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1.目的 

建立高速成像原子力显微镜 Cypher VRS 标准使用操作规程，使其被正确、规范地使用。 

2.范围 

本规程适用于所有使用高速成像原子力显微镜 Cypher VRS 的用户。 

3.职责 

3.1.用户：严格按本程序操作，发现异常情况，尤其是仪器故障时及时汇报实验室技术

员；隐瞒不报造成仪器进一步损伤将加重处理。 

3.2.实验室技术员：确保操作人员经过相关培训，通过考核，并按本规程进行操作。 

4.实验室安全管理规范 

4.1.进入实验室的所有师生应熟悉消防安全基本知识、化学危险品安全知识、用电/用水/

用气常识。 

4.2.严格遵守实验室的各项安全管理规范，注意警示标识。 

4.3.实验室仪器需经培训考核后方可操作，并严格遵守仪器标准操作规程（SOP）进行

检测，未经考核者严禁上机。严禁未经允许进行 SOP 以外的其他操作，或擅自修改

仪器硬件及软件设置、使用非指定部件，或在拆下安全装置的情况下操作仪器。 

4.4.严禁在实验室的仪器电脑主机上使用 USB 拷贝数据，严禁私自接入外部网络。 

4.5.用户自主测试必须严格按照 SOP 进行，实验过程中不得擅自离开实验室；实验结束

后，整理好实验相关区域并做好实验记录。实验室技术员应经常巡视，及时纠正违

规操作，消除安全隐患；  

4.6.用户须在制样区完成制样工作，并保持工作区域整洁，相关工具放置在指定位置；

仪器操作区要保持整洁，相关工具和资料放置在指定位置；严禁摆放与实验无关的

个人物品；严禁在实验室饮食与抽烟。 

4.7.禁止将自己的账号借给他人使用，尤其不可借给没有操作权限的人上机操作，一经

发现，直接取消使用资格。 

4.8.严格遵守学校规章制度，有毒废物、试剂、器皿、利器等分类回收。 

4.9.实验室人员离开前必须认真检查实验室的水、电、气是否关闭，离开时随手关门。 

4.10.仪器操作过程中出现异响、异味、冒烟等异常现象时，请第一时间联系实验室技术

员。 
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4.11.因违规操作或其他失误造成安全事故，相关责任人将受到通报批评及相应处罚。 

5.实验室仪器设备管理规范 

5.1.高速成像原子力显微镜 Cypher VRS 使用制度 

该仪器遵从学校对大型仪器设备实行的管理办法和“集中投入、统一管理、开放公

用、资源共享”的建设原则，面向校内所有教学、科研单位开放使用；根据使用机时适

当收取费用；并在保障校内使用的同时，面向社会开放。 

高速成像原子力显微镜 Cypher VRS (以下简称高速成像 AFM)检测方案分为五类： 

(1) 培训测试：用户提出培训申请，技术员安排培训。培训内容包括：实验室规章

制度说明、环境控制 AFM 基本原理、硬件构造及各部分功能介绍；常规样品制样、仪

器的标准操作流程、控制软件(AR.18.xx.xxx，持续更新)操作、数据处理及测试注意事

项。该过程中用户在技术员指导下进行操作仪器并进行数据处理。 

(2) 自主测试-初级：用户独立安装探针、制样、装样、独立操作高速成像 AFM，

进行气相轻敲模式测试形貌、高度、粗糙度信息，并进行简单的数据处理。 

(3) 自主测试-中级：用户独立安装探针、制样、装样；独立操作 AFM 除初级操作

外，进行液相、电学、力学的测试。 

(4) 自主测试-高级：用户独立安装探针、制样、装样；独立操作 AFM 除初级、中

级操作外的其他测试模式，包括原位测试以及根据用户的定制化需求设计实验方案进行

测试。 

(5) 送样测试：用户预约时提供样品信息及测试要求；用户负责制样，技术员操作

仪器并做基本数据处理； 

该仪器的使用实行预约制度，请使用者根据样品的测试要求在学校“大型仪器共享管

理系统”(以下简称大仪系统)进行预约，并按照要求登记预约信息。 

5.2.预约制度 

为充分利用仪器效能、服务全校科研工作，根据测试内容与时间的不同，实验室制

定了高速成像 AFM 7*24 小时预约制度。根据预约制度可登陆大仪系统网站最少提前 2

小时预约机时，包括周末；国庆、春节假期等较长的假期，预约制度根据学校和平台要

求及时调整。 

高速成像 AFM 采取综合计费制度，请遵守预约时间使用仪器，迟到、超时、爽约

导致的机时占用，均会收取费用，如果预约不合理，占用他人的机时，用户之间若无法
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协商，则根据实际预约的时间为准。。 

(1) 校内使用者须经过技术员的实验操作培训，考核合格后方可上机使用； 

(2) 实验开始时务必在实验记录本上登记，结束时如实记录仪器状态； 

(3) 严禁擅自处理、拆卸、调整仪器主要部件。使用期间如仪器出现故障，使用者

须及时通知技术员，以便尽快维修或报修，隐瞒不报者将被追究责任，加重处理；  

(4) 因人为原因造成仪器故障的(如硬件损坏)，其导师课题组须承担维修费用； 

(5) 不可擅自做除培训操作之外的测试，如有需求请务必联系技术员；  

(6) 数据不允许用 U 盘与移动硬盘直接拷贝。使用者应根据要求通过数据共享系统

保存和下载原始数据至本地电脑；实验数据在本实验室电脑中保留 2 个月(暂定，根据

情况若硬盘允许数据保存时间延长)。 

(7) 使用者应保持实验区域的卫生清洁，测试完毕请及时带走样品，本实验室不负

责保管样品。 

(8) 实验室提供镊子、螺丝刀、胶带、银胶等专用装针和制样工具，请合理使用，

用户不得私自带走。 

(9) 使用者若违犯以上条例，将酌情给予警告、通报批评、罚款及取消使用资格等

惩罚措施。 

5.3.培训考核制度 

校内教师、研究生均可提出预约申请，由技术员安排时间进行培训，培训分为三部

分： 

第一部分：由实验室技术员介绍实验室规章制度、安全管理规范、仪器设备原理、

基本硬件知识。 

第二部分：上机培训，内容包含：装针、制样、仪器标准操作规程、相应数据处理。 

第三部分：上机培训结束后，培训者需根据实验安排，使用自己的样品进行预约上

机测试（建议两周以内），在技术员的监督下进行独立操作。待培训申请人觉得可以独

立操作后向技术员申请进行上机考核。 

考核通过之后，技术员会给予培训者授权，培训者即可独立使用仪器，但仅限在其

用户级别所允许的可操作实验范围内使用。个别因为人为操作错误导致仪器故障者，除

按要求承担维修费用之外，给予降级重考惩罚、培训费翻倍。 

注意：培训中的第一部分和第二部分需要用户在一周内完成(特殊情况除外)，否则需要重新进行

培训；培训通过后用户需保证每两个月至少 1 次的自主上机测试，若超过该时间则需要重新联系仪
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器负责人监督考核，否则将无法预约该仪器设备。考核不达标者需要重新申请培训，且培训费用是

初次培训的 1.5 倍。 

对接受培训人员的核心要求： 

(1) 熟悉高速成像 AFM 原理、构造及各部分的功能，严格遵守仪器部件的开关顺

序，在突然停电时能及时处理并上报，关注仪器各部件有无异常； 

(2) 熟练掌握高速成像 AFM 的原理及操作，严格按照标准操作规程操作，防止因

人为操作不当造成仪器故障，特别注意 holder 的安全使用、手动预下针操作、scanner

的安全操作，人为原因造成的仪器事故，所属课题组须承担维修费用，认真做好高速成

像 AFM 的使用及故障记录。 

5.4.仪器故障报告 

(1) 仪器使用过程中，仪器出现故障及错误提示信息时，应即时通知技术员； 

(2) 请在第一时间将故障及错误提示信息截屏，并保存在桌面“Error Report”文件夹，

截屏文件命名请按照“导师名-用户名-样品名-故障时间(具体到分钟)”；在《仪器设备使

用记录本》的备注栏做简单说明。 

6.高速成像原子力显微镜 Cypher VRS 标准操作步骤 

6.1.介绍 

基本信息：高速成像原子力显微镜 Cypher VRS 主机（包括主体、光路系统、控制

器、VRS 扫描器，电脑及操作软件）；气相成像模式、液相成像模式、电学模式、MFM

模式、力学模式、扫描热模式、buleDrive 光热激发模块、热台模块、环境控制功能。 

仪器主要技术参数： 

➢正常速度扫描成像时： 

X,Y 轴扫描范围：30μm； 

闭环噪音<60pm 

Z 轴扫描范围>5μm; 

系统高度噪音<15pm 

➢快速扫描成像时： 

X,Y 扫描范围： 10μm 

闭环噪音<60pm（Adev,0.1Hz-1kHz） 

Z 轴扫描范围>2μm; 
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系统高度噪音< 15pm（Adev,1Hz-1kHz）; 

扫描线速度：最高 1250Hz； 

 

环境控制系统：集成的环境控制扫描器,可密封 

气体控制：密封，可进行气体控制 

温度控制：0-120℃，可密闭环境中加热 

导电测试：电流范围：4pA-10μA。 

扫描热模式：温度灵敏度 0.01℃，最高温度＜700℃  

 

环境控制原子力显微镜 Cypher ES 主要组成部分如下，如图 6-1 所示： 

 

图 6-1 高速成像原子力显微镜 Cypher VRS 系统图示 
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图 6-2 环境控制样品腔示意图 

 

6.2.样品准备 

测试样品要求干净，表面平整，高度起伏不要超过 5μm，最大尺寸直径小于 15mm，

高度小于 7mm，如果样品在衬底上有指定位置，建议样品小于 5*5mm。 

 

6.3.探针准备 

根据用户自己的样品自备探针，如果是比较重要的样品，或者测试结果用于文章发

表，建议使用新的探针。公共探针仅用于培训，用户独立测试不提供探针。 

 

6.4.系统检查 

测试前请完成如下检查： 

测试前先确认 Controller 的 Power 灯亮，Laser 钥匙位于 Off 的位置。如果不是该状态，

请联系仪器负责人。 

                              

图 6-3 
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6.5.制样 

   利用双面胶、导电银胶、AB 胶将样品粘到样品托上（样品托直径约 15mm），请将

待测区域尽量放置在样品托中心位置。制样前请检查样品托是否干净，务必要正反面都

光滑干净没有残胶，否则样品会无法移动。 

警告：1. 制样时，需要确保待扫描的区域位于样品的最高点，更不要如下图 6-4 所示在样品托上放

置比样品高度更高的物体，一个样品托上只放置一个样品。 

2.  AFM 的制样工具，样品托、镊子、螺丝刀均为实验室公共用品，请爱惜使用，不可带走。 

3.  测试开始和结束后，需用无尘纸蘸取酒精认真清洁样品托的两面，并带走或者处理自己的样品，

不可一直占用公共样品托。 

                      

图 6-4 

6.6.仪器操作 

（1）输入账号和密码，登录大仪系统，进入电脑桌面。 

（2）在电脑桌面上找到双击打开软件“AR19”，打开控制器上的激光开关 Laser，从“off”

旋到“on”（以上两项顺序无固定要求）。等待软件下方显示“Ready”和绿底的√： 

 

（3）选择测试模式。在当前软件中会弹出 “Mode Master” 窗口，选择 “AC Air 

Topography”，进入轻敲模式的软件环境。如果没有弹出该窗口，点击软件左下方的

按钮 。 
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图 6-5 

（4）装针 

i．请在装针前，根据测试模式选择正确的 holder，并检查 holder 是否有异常，如裂

痕、脏污等问题，发现问题请及时告知仪器负责人。 

ii．用洗耳球吹扫一下弹片，确保没有探针残渣。转动螺丝半圈（不要过多！），使

压探针的弹片弹起，探针可移动即可。 

iii． 用专用的探针镊子夹取探针 chip 的中间部分，小心的放在 holder 的压片下，大约

压在 chip 的一半左右的位置，稍微拧紧压片的固定螺丝即可。 

警告：1. 装针前用氮气枪或者吸耳球认真吹扫 holder 的压片和玻璃部分，确保没有 chip 的碎片残留，

否则拧紧螺丝时可能会损伤玻璃。 

2. 固定螺丝时，稍微拧紧固定探针即可，请勿过度用力，导致压片变形翘起，进而导致玻璃受力越

来越大，出现损坏。 

3. 拧松螺丝时，不要超过半圈，压片抬起即可，不慎将螺丝拧掉，会有丢失和滑丝的风险，后果非

常严重，有可能会导致整个 holder 需要更换，务必注意。 

4. 在手持 holder 时，只碰触 holder 两侧的塑料部分，尤其注意不要用任何尖锐的物品碰到 holder 表

面的铜线和芯片，否则可能导致 holder 损坏，无法识别。 

5. 务必拿稳 holder，不慎掉落造成玻璃损坏或 holder 无法识别。 

（5）放样品。打开 AFM 主机隔音罩的门，将 Scanner 右侧的黑色把手抬起，轻轻将

Scanner 拉出一半左右，然后用专用的弯头镊子将样品放在样品台上。 

注意：请勿将 Scanner 拉出超过其侧面宽度的一半的距离，即中间螺丝处，以防其滑出隔音罩。 
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（6）安装 holder。务必确认样品和 holder 之间有足够的距离，不要在安装 holder 的过

程中撞到探针。如下图 6-6 所示，将 holder 上的两个孔隙分别对准 Scanner 上两根

螺丝，轻轻向下压 holder，以压紧 holder 上的橡胶 O 圈，增强腔体的密闭性，然后

顺时针旋转 holder，将金色芯片插入槽内，再用 scanner 旁边的专用螺丝刀分别拧紧

两颗螺丝。 

警告：安装 holder 过程中，撞到探针，不仅会损坏探针，还可能导致 holder 损坏，请务必检查距离！ 

                      

图 6-6 

（7）将 Scanner 推回初始位置，并将其右侧的黑色把手拉下，确认物镜的聚焦校正环（图

6-7）对应在 1.5 的位置，关上隔音罩。 

                    

图 6-6 

（8）肉眼观察探针和样品之间的距离，并小心缓慢的旋转 AFM 主机上的旋钮，直至探

针下降至样品表面 2-3mm 左右的位置。 
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警告：探针下降的速度随着旋钮扭动幅度的变大而变快，建议用户以小幅度来扭动旋钮，以防探针

撞到样品上，严重的情况下会损坏 holder 和 Scanner。 

注意：如果探针没有随着旋钮扭动而下降，需要对样品台初始化，详见步骤（9），待初始化过程结

束，再进行（6）-（8）操作步骤。 

（9）初始化样品台。每次重新启动控制器时，系统会在 Engage Panel 自动提示初始化，

取下扫描器上安装好的 holder（如有），点击“Initialize Motor”按钮，如图 6-7（如

果没有重新启动控制器，则无此步骤）： 

 

图 6-7 

（10）聚焦探针。如图 6-8 所示，在“Video”窗口，在 Zoom1.0 条件下，点击上方的“Home”

按钮，注意观察 Video 窗口，会大致看到悬臂梁的轮廓，或者可以判断出悬臂梁位

于当前视场的哪个方向，可以使用左上方标黄的 CCD 按钮移动或寻找探针。之后

在“Engage Panel”窗口中，上下调节物镜焦距（请注意！要选择“Move Focus”才能调

节物镜），单箭头为慢聚焦，双箭头为快聚焦。确定针尖聚焦面后，点击“Focus On 

Tip”旁边的“SET”。 
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图 6-8 

（11）针尖定位。在“Video”窗口，点击“Tip Pos”，鼠标箭头会变成一个小旗子，

放在针尖上，然后鼠标再次点击“Tip Pos”，变回鼠标箭头模式。 

（12）下激光。在针尖上点击右键，选择“Spot On”，此时，激光光斑应出现在相应位置，

可以借助左上角标黄的箭头调整激光的位置，按住 Shift 键可以实现微调。 

激光调整原则：①尽量靠近针尖；②“Sum and Deflection Meter”窗口中，“Sum”值尽量大，

在 3 以上；③不要漏光。 

（13）聚焦样品表面。继续向下调节聚焦，直至聚焦在样品表面上，点击 Focus on Sample

的右侧的 SET 按钮，此时可以看到 Sample Height 的数值会更新。 

（14）点击图 6-8 中标黑的“Move To Pre-Engage”按钮，这会使探针位于样品表面 50μm

的位置。观察激光光斑是否有偏移，如果有可以微调其位置。 

警告：如果前面设置的探针位置和样品高度错误的话，这一步很有可能会使探针撞到样品上发生损

坏！所以两个聚焦面设置好之后，请仔细检查一下！防止探针撞坏，甚至 holder 再进一步撞到样品

上，造成更严重的设备损坏！ 

（15）点击“Sum and Deflection Meter”窗口的 Zero PD，使 Deflection 调零（接近 0 即可）。 
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（16）寻峰/Tune，即寻找所用探针的共振频率并设置空气的 Free Amplitude 值（Target 

Amplitude），点击“Master Panel”窗口右侧栏的“Tune”按钮。“Cantilever Tune”窗口

会弹出，点击“Auto Tune”按钮即可。稍等片刻，可以观察到寻峰结果，寻峰得到的

相关参数（Drive Amplitude 和 Drive Frequency）会自动保存，此时可以关闭该窗口。 

注：可以根据探针盒子上标明的频率范围，点击该窗口右侧的“Parms.”，手动修改 Auto Tune Low/High

的值，设置寻峰范围。 

 

    

图 6-9 

 

（17）设置扫描参数。 

 

图 6-10 
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i．“Scan Size”：扫描图片的区域大小，Cypher 的扫描上限为 30μm，根据需要自行设定； 

ii．“Points&Lines”：图像分辨率，每行的扫描点数*扫描行数，请选择 256 的倍数； 

iii．“Scan Rate”：扫描速度，通常 2.44Hz 以内；较软的样品，建议扫描速度慢一些； 

——以上三项参数，均根据实际的实验需求设置，还可以点击右侧栏中的“Parms.”，在

弹窗中进行更多设置。 

iv．“Setpoint”：在轻敲模式下，Setpoint 和悬臂的自由振幅 Free Amplitude（即为 Auto 

Tune 步骤中设置的 Target Amplitude）的比值体现扫图过程中探针力的大小，所以

Setpoint 的数值必须设置为小于自由振幅 Free Amplitude 的值，推荐 Setpoint 的值在

Free Amplitude 的 50%-80%之间。通常 Auto Tune 时，将自由振幅设为 1V，所以可

以近似理解为 Setpoint 值越小，探针施加的力越大，反之亦然。 

v．“Integral gain”：反映了系统反馈的灵敏度，为了得到高质量的图像，在扫描过程中，

建议尽可能增大，以提高灵敏度，直至图像尚未产生噪音为止。 

vi．“Drive Amplitude”：表示压电陶瓷的驱动振幅，扫图过程中，如果调小 Setpoint 依

旧不能得到满意的结果，可以增加该值，会增加探针的自由振幅，建议 Drive 

Amplitude 和 Setpoint 同步调大，以保护探针。 

——以上三项参数，在扫描过程中根据图像情况实时调整。 

（18）下针。点击“Engage Panel”窗口中的“Start Tip Approach”按钮，开始自动下针，下

针成功后会有警示音发出。 

 

图 6-11 
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（19）开始扫描。在“Master Panel”界面，点击“Frame Up”或者“Frame Down”开始扫描。 

 

图 6-12 

注：轻敲模式下 AFM 会检测悬臂振幅的变化。随着探针向下移动，悬臂的振幅也会随之衰减， 当

其从  Free Amplitude 衰减到  Setpoint 时即认为下针成功。所以可以理解当我们加大  Drive 

Amplitude（导致 Free Amplitude 加大），或者减小 setpoint 时，都会导致探针向下移动的距离 增

加，即探针与样品的距离变小。 

（20）扫描过程中参数的调节。扫描过程中应观察 Height Retrace 窗口下的红蓝线是否

重合，图像质量是否 OK，如果红蓝线完全重合，表明此时的扫描参数设置的合理，

不需要进一步调节。  

如果红蓝线并不重合，可以尝试如下几步： 

~增加探针的力的大小，即减小 setpoint 或者增大 Drive Amplitude。注意：setpoint 和

Free Amplitude 的比值关系。 

~增加反馈系统的灵敏度，即增大 Integral Gain 值。注意：过大的 gain 值会引起系统震

荡，体现为图中出现明显波纹状噪音。  

~降低扫描速率即减小 scan rate。 

~若仍不能使红蓝线重合，应考虑探针选择是否合理，或是否当前探针已经被污染或磨

损，尝试更换新的探针。 

（21）图像显示参数的调节。在“Master Channel Panel”界面的上方一栏或者在“Input”的

下拉菜单中，可以选择想要设置的图像通道（Height/Amplitude/Phase/ZSenor）。 
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图 6-13 

i.“ColorMap”：可以选择图像颜色，在其下拉菜单中，点击一下“Setup”，可以获得更多

颜色选择。 

ii. Image Modification 中，“Real Time”选项，可以选择合适的实时数据拉平条件，一

般选择 Flatten 1，“Saved”选项中，对 Height 选择“None”，以保存原始数据，也可根

据样品实际情况选择。 

（22）关于引力扫描和斥力扫描 

i．在轻敲模式下，相位/Phase 值的大小可以反映探针和样品间作用力的类型，当 Phase< 

90°时 处于斥力模式；而当 Phase> 90°时处于引力模式。 我们通常认为引力扫描时，

由于探针并未“真正的敲击”在样品上，所以对于探针和样品的保护性都很好，但牺牲了

一定的图像分辨率。而斥力扫描则相反，往往可以得到较为“清楚”的扫描图像，但是对

于探针和样品也会多多少少有一点磨损。 我们可以根据自己的样品来选择引力或斥力

模式进行扫描，但注意一定要避免探针不断在引力与斥力模式间跳动（mode hopping），

即 Phase 不断在 90°上下跳动。  

ii．使探针在扫描过程中维持在斥力模式 ：通过增加 Drive amplitude 从而使探针的 free 

amplitude 增大，越容易进入斥力模式。 设置的 setpoint 越小，越容易进入斥力模式。 

iii．值得注意的是，之前谈到过扫描过程中探针上力的大小取决于 setpoint 和 Free 

amplitude 的比值，所以在调节这两个值的时候需要保持这个比值大约在 50%~80%之
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间，即在逐渐增大 Drive amplitude 的同时也逐渐增大 setpoint，直到 phase 稳定在小于

90°的范围内。 

iv．能否进入斥力模式，和探针、样品都有关系。 

样品越黏，越软，有静电力，都会造成难以进入斥力模式。  

探针越硬（k 值越大），越容易进入斥力模式。  

探针越尖，越容易进入斥力模式。所以磨损的或者污染的探针，可能不容易进入斥力模

式。 

（23）其他注意事项。 

i.下针之前，根据 Video 界面，初步确认想要测试的样品位置和范围 

ii.开始之后，检查一下“Sum and Deflection Meter”界面中的 Z Voltage 的值，推荐在中间

区域，70-80 左右，如果一直处于最大值（150），则说明之前下针未成功，需要停

止扫描“Stop”，减小 Setpoint 重新下针，再开始。如果一直处于最小值（-10），这

说明之前样品表面定焦有问题，需要停止扫描“Stop”，点击“Move To Pre-Engage”，

增加 Setpoint 重新下针，再开始。 

iii.如果扫描过程中想改变区域，停止扫描（“Stop”），点击“Pre-Engage”，再移动样品

台，切勿直接移动探针，有可能损坏探针！ 

6.7 实验结束 

扫描结束后，点击 Engage Panel 中的(Un)Load Sample 退针，取下探针，收起样品，

关上激光并关上软件，退出大仪系统，收拾桌面和制样区，在实验记录本上做好使用登

记。无需关闭控制器和电脑。 
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6.8数据处理及保存 

注意：该仪器的原始数据格式为 ibw 文件，需要用 AR 自己的软件打开和处理，由于软件收费，可

用原子力显微镜实验室的公共电脑进行处理，或者使用开源软件 Gwyddion 处理，后者请用户自己

下载和学习。 

（1）保存数据。扫完一幅图，软件会自动保存数据，默认保存在以当天日期命名的

文件夹中。实验数据使用校内共享存储系统进行上传和下载，首次使用需要用户使用桌

面的快捷方式自行建立自己的文件夹。建议选择需要的数据复制粘贴到自己文件夹中。 

（2）打开数据。方法一：点击菜单栏中的 AFM Analysis→Browse Save Data，在弹

出的 AR Load Path 面板中，点击 Browse，选择数据所在文件夹，在弹出的 Browse 面板

中，可以看到文件夹中的数据，如果要更改路径，点击 Browse 面板的 Change Directory

按钮。 

 

图 6-14 

方法二：Browse 面板中，双击图标就可以打开数据。如果想直接打开已有的数据 ibw

文件，首先打开 AFM 软件，再把 ibw 文件拖进去，最好不要用双击 ibw 文件的方式打

开数据。 

（3）数据后处理。点击图像上方的 M 按钮，打开 Modify 面板。 
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图 6-15 

Modify 面板最常用的功能是 Flatten 和 Planefit，它们的作用是拉平形貌图像（Height

高度图和 Z Sensor 图），Flatten 和 Planefit 一般不用于形貌图之外的图像。 

 

图 6-16 

Planefit 是将形貌图整体调平，消除图像的倾斜。选中所要处理的图像和通道，

Planefit Order选择1，点击XY（代表Planefit作用于图像的X和Y方向）。1阶和Histrogram 

Planefit 最常用，0 阶只消除 offset，用处不大，2 阶可能改变形状，慎重使用，请根据

最终图像的消除倾斜的效果选择。 
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图 6-17 

Flatten 是将 AFM 的扫描线逐一对齐。Flatten 是逐行调平、对齐，类似于对每条线

分别做 Planefit。选中所要处理的图像和通道，选择合适的 Flatten Order，点击 Flatten，

如果效果不好，可点击 Undo Flatten。1 阶和 Histrogram Flatten 最常用，0 阶 Flatten 可

以对齐线，也会用到，2 阶可能改变形状，慎重使用。 

 

图 6-18 

以上对图像的处理（Flatten，Planefit），都只对内存中的数据生效，硬盘中保存的

数据不受影响。重启软件后打开数据，依然是处理之前的样子，要保存对图像的处理，

可以选择 Commands 下拉菜单的 Save Image（覆盖原数据），或者 Save As …（数据另
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存为），对图像进行后处理（Flatten，Planefit）之后，都可通过点击 Restore Layer 或者

Ultra Restore Layer 恢复原始数据，不必担心保存更改后回不去。 

 

图 6-19 

 

（4）图片颜色和对比度调节。在数据中的 ColorMap 下拉菜单可以选择颜色表，点

击 Auto 可以自动调节颜色的显示，利用 Range / Offset 可以手动调节颜色的显示。 

 

图 6-20 
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（5）导出图片或数据。 

i．选中图像，菜单栏 File→Save Graphics，在 Format 选择导出的格式（一般选择 TIFF

格式），点击 Do It，设置导出的名称和路径。 

ii．点击图像上方的 Ly 按钮，也可以将图像复制到 Layout（类似一个剪贴板），除了图

像，截面线、直方图、Mask 等元素也可以保存到 Layout，Layout 可以通过菜单栏

File→Save Graphics 或者 Print Layout 保存为图片或 PDF 报告。Layout 中的元素也可以

被复制粘贴到 Office 软件中。 

iii．AFM 图像是一个个数据表格，数据可以导出，在数据图片的 Commands 下拉菜单，

选择 ASCII Export，即可保存为 txt 格式。 

iv．对于形貌图（高度图和 Z Sensor 图），软件也可以生成 3D 图像，点击图像上方的

3D 按钮，就会生成 3D 图像。鼠标左键旋转模型，右键改变光照角度。3D 图像不能用

Save Graphics 导出，要用菜单栏 Edit→Export Graphics 导出。 

6.9 数据分析。 

数据分析的功能主要在 Analyze 面板，点击图像上方的 A 按钮，打开 Analyze 面板。

常用的数据分析工具有 Roughness（粗糙度等统计值）和 Section（截面线）。 

 

图 6-21 

（1）Roughness 页面给出形貌图的统计信息。Sdev [Rq]和 Adev [Ra]常用来描述粗糙度；

Max / Min：数据点中的最大值/最小值；Avg：数据点的平均值；Area：样品表面积；

Area %：样品表面积相比扫描范围多出来的比例；Volume：样品体积，相对于 Z = 0 平

面。 
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图 6-22 

（2）Section 用来读取图像在一条线上的数据。对于形貌图来说，就像做了一个截面。

点击 Draw，在图像上画一条线，出现截面线，拖动两个光标可以改变线的位置，点击

Clear 可以删除截面线。Mode 有两种，Line（直线）和 Free Hand（自由轨迹）；在 Line

直线模式下勾上 Full，截面线贯穿图像；在 Line 直线模式下勾上 Angle 方框，输入角度

值，可以限定线的角度；增大 Width，截面线变宽，有平均的效果，数据可能更平滑； 

 

图 6-23 
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截面线窗口的下方是 Cursor 工具栏。 Cursor 工具栏可以通过键盘的 Ctrl+I 隐藏或

显示，用鼠标把 Cursor 拖到曲线上，就可以得到那一点的 X 和 Y 数值。用两个 Cursor，

还可以知道它们的 X 差值和 Y 差值。在截面线窗口点击 Edit，会出现数据表，可以保

存为 csv 文件或复制到别的软件； 

 

图 6-26 

 

7.相关/支撑性文件 

7.1 Q/WU FLHR001 文件编写规范 

8. 记录 

8.1 高速成像原子力显微镜 Cypher VRS V1.0 



环境控制原子力显微镜标准操作规程 V1.0                             第 24 页 /共 24 页 

  

 

仪器设备使用记录本                                20   年 

日期 

月.日 
测试人 导师（PI） 样品名称 

实验内容 

（Contact/AC/CAFM/

PFM/Force Curve……） 

检测方式 

使用时间 备注 
培训 送样 自主 

          

          

          

          

          

          

          

          

          

          

请注意：(1) 使用前先检查仪器状况，一切正常方可操作；一旦开始实验，默认为使用前仪器及各个配件状况良好；(2) 使用过程中出现故障须立即联系技术员；测试
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后请及时取回样品;  


